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Introduction 

Introduction to DSC Data Analysis 

MicroCal Origin is a general purpose, scientific and technical data analysis and plotting 
tool. In addition, Origin can carry add-on routines to solve specific problems. Analyzing 
Differential Scanning Calorimetric data from the MicroCal MC-2, MCS or VP-DSC 
instruments is one such specific application. 

This version of Origin includes routines designed to analyze DSC data. Most of the DSC 
routines are located in the Peak and DSC (Differential Scanning Calorimeter) menus in 
the Origin menu display bar. A number of routines are implemented as buttons in plot 
windows. This tutorial will show you how to use all of the DSC routines. 

Lesson 1 provides an overview of the entire DSC data analysis and fitting process. Please 
work through this lesson first. The subsequent lessons each look in more detail at 
particular aspects of DSC data analysis, and may be read in whatever order you see fit. 

If you are unfamiliar with the basic operation of Origin, you may find it helpful to read 
through the Origin User’s Manual (particularly the introductory chapters and first several 
chapters) before beginning this tutorial. Note that this DSC tutorial contains information 
about Origin only in so far as it applies to DSC data analysis. For a complete discussion 
of Origin's capabilities, please refer to the Origin User’s Manual. 

If you have questions or comments, we would like to hear from you. Technical support 
and customer service can be reached at the following numbers: 

Toll-Free in North America: 800.633.3115 

Telephone: 413.586.7720 

Fax: 413.586.0149 

Email: info@microcalorimetry.com 

Web Page: www.microcalorimetry.com 
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Getting Started 

Getting Started 

In this chapter we describe how to install Origin on your hard drive, how to configure 
Origin to include the DSC add-on routines, and how to start Origin. We recommend that 
you read your Origin User’s Manual for a complete guide to all of Origin's features. 

System Requirements 

Origin version 5.0 requires the following minimum system configuration: 
• Microsoft Windows® 95 or later, or Windows NT® version 4.0 or later. 
• 486/DX or higher processor. 
• 8 megabytes (MB) of RAM (16 MB recommended). 
• One 3.5-inch high-density disk drive. 
• 12 MB of available hard drive spaces. 

Installing Origin 

To install a new copy of Origin or to upgrade an existing copy, run the program 
SETUP.EXE located on Disk 1, the Setup disk. The Setup program guides you through 
the installation process. Installation requires 12 MB of free disk space on the drive where 
you intend to install Origin. Additionally, installation requires 8 MB of free disk space on 
the Windows drive (where your Windows operating system is installed) for temporary 
files. Thus if you are installing Origin onto your Windows disk drive, 20 MB of free disk 
space is required during installation (only 12 MB of free space is required after 
installation is completed). 

The Setup program prompts you to type in your Origin serial number. If you are 
upgrading your version of Origin, your new serial number is located on the serial number 
label affixed to the Origin package, or on the packing list. If you are a new Origin user, 
your serial number is located on your registration card, or on the serial number label 
affixed to the bottom of the Origin box. 

To start the Setup program, perform the following: 
(Please refer to the 'Origin : Getting Started Booklet' for further information) 

(When choosing a Destination Directory (or folder) name to place Origin make sure this name or any other 
name in the path does not include a space, otherwise Origin will not operate properly) 

1. Start Windows 95, Windows 98 or Windows NT® version 4.0 or later. 
2. Close all Windows programs (if any are open). 
3. Insert the Origin Setup disk in the available floppy drive A: (or B:). 
4. Click Start, the select Run. 
5. Type A:\Setup (or B:\Setup) in the Open text box. 
6. Click OK. The dialog box closes and the Origin Setup program begins. 
7. If you have a previous version of Origin you may want to install Origin 5.0 in a separate program 

folder. Please change the program folder to be MicroCal Origin50 (from the default MicroCal Origin 
name) when prompted. (see Origin's Getting Started Booklet for more information) 

8. Follow the instructions presented by the Setup program to complete the installation. 
9. After disk 5 is completed make sure the 'X'is in the box to select the Custom disk installation (this disk 

contains the DSC specific routines) and click Next. 
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DSC Data Analysis Tutorial Guide 

The installation program automatically creates an Origin50 folder and window containing 
the program icons. 

After installation is complete, you may right click on the MicroCal Inc. DSC icon and 
select copy from the drop down menu, then right click anywhere on the desktop and select 
paste to install a desktop icon for Origin DSC. 

Registering with MicroCal Software 

MicroCal™ Software, Inc., a separate company from MicroCal™ , Inc., produces and 
supports the Origin software package. MicroCal™, Inc. produces and supports the 
calorimetric fitting routines imbedded in the Origin for DSC and Origin for ITC 
packages. MicroCal, Inc. will provide technical support for all aspects of the software 
without registration. MicroCal Software will not provide technical support for the 
calorimetric fitting routines, but if the copy is registered, will provide standard technical 
support for the general purpose routines of the program . 

Upon receipt of Origin, please fill out and return the registration form included with your 
package to MicroCal Software. You may also register at any time by contacting the 
Customer Support Department at MicroCal Software. 

Starting Origin 

To start Origin, double-click on the Origin 5.0 program icon on the Desk Top. 
Alternatively, click Start, then select Programs. Point to the MicroCal Origin50 folder 
and select the MicroCal Inc. DSC program icon from the submenu. 

Menu Levels 

This DSC version of Origin comes with three distinct menu configuration options, or 
menu levels (four, if you also purchased the optional ITC software module). Each menu 
level has its own distinct menu commands. After Origin has opened you may change a 
menus level option under the Format:Menu command option. 

The four menu levels are: 

General Full Menus - Select this option to run Origin in the generic, non-instrument 
mode. This menu level contains no instrument-specific routines, but does contain many 
general data analysis and graphics routines that you may find useful for other 
applications. You will find these general routines described in your Origin User’s 
Manual. 

DSC Data Analysis - Select this option to run Origin in a configuration that includes the 
instrument-specific DSC data analysis routines. 

ITC Data Analysis - Select this option to run Origin in a configuration that includes the 
instrument-specific ITC data analysis routines. Note that this menu level is available only 
if you purchased the optional ITC software module. 
Short Menus - Select this option to run Origin with menus that are an abbreviated 
version of the General Full Menus configuration. 

4 



  

 

                  
                 

               

             

      

              
             

               
                 

              
     

 
        

  

                 
        

 
                 

               
             

                
                  

               
    

 
             

              
       

 
               

              
               

               
     

 
                

                   
   

 
                  

                 
        

 
               

     

Getting Started 

Note that you cannot switch to a new menu level if there is a maximized plot window or 
worksheet in the current project. A warning prompt will appear if you try to switch levels 
while a window is maximized. If this happens, simply click on the window Restore 

button. You will then be able to switch levels. 

Simultaneously Running DSC and ITC Configurations 

If you purchased both the DSC and ITC software modules, the installation program will 
have automatically created icons in the MicroCal Origin50 program group for the DSC 
and the ITC software. This allows you to run two configurations simultaneously. The 
most likely reason to do this would be if you have both the MicroCal ITC) and the 
MicroCal VP-DSC (MCS DSC or MC-2 DSC) calorimeters, and you intend to run them 
both on the same computer. 

Double-click on either icon to run that configuration. 

View Mode 

Each Origin plot window can be viewed in any of four different view modes: Print View, 
Page View, Window View, and Draft View. 

Print View is a true WYSIWYG (What You See is What You Get) view mode. This 
view mode displays a page that corresponds exactly to the page from your hard copy 
device. Exact font placement and size is guaranteed, at some sacrifice to screen 
appearance, since the printer driver fonts must be scaled to fit their positions on the page 
(this will not harm the appearance of true vector fonts). This is a slow process, and screen 
refresh speed suffers as a result. Thus, reserve the Print View mode for previewing your 
work prior to printing. 

Origin automatically changes to Print View mode when graphics are exported to another 
application and when printing. The view mode automatically returns to the selected view 
mode after the operation is complete. 

Page View provides faster screen updating than Print View , but does not guarantee exact 
text placement on the screen unless you are using typeface scaling software (such as 
Adobe Type Manager). Use Page View mode until your application is ready for printing 
or copying to another application. Change to Print View mode to check object placement 
before exporting, copying, or printing. 

Window View expands the page to fill up the entire graph window. Labels, buttons, or 
other objects in a graph window that reside in the gray area of the page are not visible in 
Window View mode. 

Draft View has the fastest screen update of the four view modes. In Draft View, the page 
automatically sizes to fill the graph window. This is a convenient mode to use when you 
are primarily interested in looking at on-screen data. 

Note that view mode will not affect your print-outs. Only on-screen display is affected. 

Note About Data Import 

5 



     

 

              
             

                
                

  
 

              
                 

             
               

             
         

            
           

             
           

    
 

              
                   

              
               

               
                

   
 

                
                 

                
                

                
     

         

              
              

                  
                

                 
      

 
             
              
                  

                
                

                  
                 

              

 

DSC Data Analysis Tutorial Guide 

MicroCal offers three versions of the DSC instrument (the MC-2, the MCS and VP-
DSC). All together, there are four different data collection software packages available 
for use with these instruments - 1) a DOS-based and 2) a Windows-based package for the 
MC-2, 3) a Windows-based package for the MCS and 4) a Windows-based version for 
the VP-DSC. 

This version of Origin will accept data files from any MicroCal DSC instrument, and 
from any of the four versions of the data collection software. To import a data file 
generated by the MC-2 DOS-based data collection software, you click on the Read 
Data… button in the RawDSC plot window and select MC-2 data (*.dat) from the List 
Files of type box. To import a data file generated by the 
Windows-based data collection software (either from the MC-2, 
the MCS or the VP-DSC), you click on the Read Data… button 
in the RawDSC plot window and select DSC Data (*.dsc) from 
the List Files of type box. PLEASE NOTE: Data file names 
should not begin with a number, nor should they contain any 
hyphens, periods or spaces. 

A new "isothermal" mode of collecting experimental data is available for the VP-DSC. 
This mode may be used when it is desirable to use the DSC to monitor a process at a 
constant temperature for varying periods of time, such as when determining kinetics of a 
chemical reaction at several different temperatures (e.g., estimates of shelf life). For this 
mode data is plotted Vs time rather than temperature. Selecting Isoscan (*.dsc) will read 
in data that has been collected in the VP-DSC "isothermal" mode and will plot the data 
Vs time (minutes). 

Once a data file is called into Origin, all further operations on the data are identical, 
regardless of the original source of the data. Note that, in this tutorial, all data were 
generated by a Windows based data collection software, and so we will be using only the 
DSC data file opening procedure. If your own data files are generated with DOS data 
collection programs, you must open them via the MC-2 procedure. Refer to Lesson 1 for 
more information about data import. 

Opening and Analyzing Previous Versions of Origin (*.ORG) Documents 

To open a previous version of an Origin Document (project), select File:Open. This 
menu command opens the Open dialog box. Select Old version (*.ORG) from the List 
Files of type: drop-down list. Select the desired file from the list box and click Open to 
close the dialog box and open the document. You may then make formatting changes and 
print the graph. If you wish to analyze the previous version of the document you must 
update the document to version 5.0. 

To update a previous version of Origin Document (project), select File:Update to Origin 
5.0 Interface. All templates will be updated to new templates compatible with version 
5.0. You may then analyze the data with version 5.0. . Please note: when you update the 
Origin templates to Origin 5.0 most of the text labeling on the graphs will be lost, 
including the fitting parameters. If you want to save the old fitting parameters text, you 
must copy the text before you update to Origin 5.0. To copy the fitting parameter text (or 
any other text) right-click anywhere in the text box and select copy. After you update to 
Origin 5.0 you may right-click in any of the 5.0 templates and select paste. 
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Lesson 1 Basic Data Analysis 

Lesson 1: Basic DSC Data Analysis 

This first lesson presents an overview of basic DSC data analysis procedures. You will 
learn how to start Origin; read a DSC data file into Origin; open multiple DSC data files; 
subtract reference data from sample data; normalize data by concentration; create and 
subtract baseline data; and use Origin's curve fitting models to fit a curve to your data. 
We will also briefly discuss instrument calibration. 

After working through this lesson you will know all of the basic procedures involved in 
analyzing DSC data. Subsequent chapters look at specific procedural elements in more 
detail. 

Starting Origin 

Before starting this lesson, you should have Origin up and running. If you are in 
Windows: 

• From the Desk Top, double-click on the MicrCal Inc. DSC icon. Or alternatively 
select Start : Programs : MicroCal Origin50 : MicroCal Inc. DSC. 

When you start Origin, the program automatically opens the RawDSC plot window. 
Note that this window contains several buttons. These buttons let you execute certain 
DSC routines. 

Reading DSC Data 

Before we proceed, you should understand the difference in Origin between a data file 
and a project (or document for versions of Origin previous to 4.0) . A data file contains 
your experimental data. In order to plot the data, you must read the data file into an 
Origin project. A project (or document) will contain both the experimental data and any 
plots you have made from the data. 

To save a project, select the File:Save Project or File:SaveProject As command. The 
project saves as a .OPJ file in Origin 4.0 or higher. To open a project, use the File:Open 
command. 

To import a data file you will use the buttons that are attached to the RawDSC plot 
window. The RawDSC plot window contains six buttons, four of which are used for data 
import. These buttons are described below: 
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DSC Data Analysis Tutorial Guide 

BUTTON NAME FUNCTION 

Read Data… Reads a data file into the project. Use this button if the data were 
generated by MicroCal's data collection software. 

Offset This is useful for offsetting repetitive scans, so they do not 
overlap on the Y axis. Click once on the number 0.000 in the 
offset text box to open the offset dialog box. Enter the offset you 
wish in the +/-Step Size box (enter the offset in mcal, even 
though the data are plotted in cal) and click OK. Click on either 
scroll arrow so the proper positive or negative Y offset for the 
next data set appears in the offset field. For each successive data 
set, the offset will advance automatically by the same increment. 

Scan Rate 
Normalization If this option is selected when you open a data file, Origin 

converts from the experimental data units of mcal/minute to units 
of cal/degree. You should always leave this box checked except 
when you are checking calibration of the instrument. Click on 
this checkbox to select or de-select this option. If the box is not 
checked, then unnormalized raw data will read in as mcal/minute 

Delete Time 
Column In raw data files, separate columns are included for Y axis, 

temperature , and time for each data point. When data are being 
Scan Rate Normalized, the time and temperature data are used to 
determine scan rate whereupon the time data is discarded and 
only the normalized Y axis readings and temperature data are 
imported into the project. The operator has the option of 
importing or not importing the time data ( _time extension) into 
the project as active data, though the time data is not plotted 
automatically. 

Response Time 
VP-DSC This is used for removing small amounts of peak brodening due 

to using a feed back mode which has a response time too slow to 
resolve a peak adequately. Refer to pages 59 - 62 for more 
information. 

Absolute Cp 
VP-DSC This is used to calculate Absolute heat capacity from raw DSC 

data. Refer to pages 54 - 57 for more information. 
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Lesson 1 Basic Data Analysis 

The RawDSC window, which contains buttons that are used to import DSC data. 

Two DSC data files (SAMPLE1.DSC and REF1.DSC) are included for your use with this 
lesson. SAMPLE1 contains sample DSC data; REF1 contains the associated reference data. 
Both are located in the [Samples] sub-folder of the [Origin50] folder. These files were 
obtained on the MC-2 DSC instrument using the Windows data collection software. Files from 
MCS or VP-DSC data collection software packages are similar, but have different header 
information. 

To open the SAMPLE1.DSC sample data file and REF1.DSC reference data file 

· Click on the Read Data button in the RawDSC plot window. 
The Import Multiple ASCII dialog box appears. 

9 



     

 

 
                  

               
             

 
                 

                 
               

              
           

 
                 

        
 

                   
 

 
 

 

DSC Data Analysis Tutorial Guide 

· Navigate to the Samples folder from the Look in: drop down list box. Note: You may 
configure Origin to always look in the Samples folder (or your own folder) by 
selecting Files:Set Default Folder.. and entering the path in the text box. 

· To add the file Sample1.dsc to the lower list box, double-click on the file Sample1.dsc 
in the "File Name" list box, alternatively you may click on the file and click on the 
Add File(s) button. Note: When assigning filenames to raw data, no 
hyphens/dashes may be used in the filename, the names should not begin with a 
number nor should the letter e be followed by a number. 

· Repeat the above procedure for the file Ref1.dsc (note: you may enter any number of 
files at the same time by this procedure). 

· Click OK to plot all files in the lower list box into the RAWDSC plot window. 

10 



      

 

                 
                
                   

             
          

   

              
             

 
 

            
 

           
               

               
                 

    
 

            
        

 
            

        
 
 

 
 

   
           

            
 

 

Lesson 1 Basic Data Analysis 

You can read any number of data files into the same RawDSC window. Note that when 
multiple data plots appear in the same window, you can set the active data plot by 
clicking on the plot type icons next to the filename in the legend. A black box around the 
line/symbol type indicates the currently active data plot. Editing, fitting, and other 
operations can only be carried out on the active plot. 

Subtracting Reference Data 

In most experiments you will have obtained both sample reaction heat data and reference 
data, and will need to subtract the reference data from the sample data. 

To subtract the REF1 reference data from the SAMPLE1 sample data 

· Click on the Subtract Reference button in the RawDSC window. 
The Subtract Reference Data dialog box opens. The first file opened, in this case 
Sample1.DSC, will appear in both the Data and Reference drop down list box. Note 
that the data set listed in the Reference box will be subtracted from the data set listed 
in the Data box. 

· Select Sample1dsc_cp from the Data drop down list. Sample1dsc_cp becomes 
highlighted and will be entered as the Data. 

· Select Ref1dsc_cp from the Reference drop down list. Ref1dsc_cp becomes 
highlighted and will be entered as the Reference. 

· Click OK. 
Every point in Ref1dsc_cp is subtracted from the corresponding point in 
Sample1dsc_cp. The result is plotted as Sample1dsc_cp in the RawDSC plot 
window. 

11 



     

 

 

   

                   
                 

             
                 

            
 

     
 
           

 

 
 

    
      

    
  

 

 

 

 

DSC Data Analysis Tutorial Guide 
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Viewing Worksheet Data 

The series of values from which Origin creates a data plot is called a data set. Each data 
set is contained in a unique worksheet column. The data set is named after its worksheet 
and worksheet column, separated by an underscore. When you opened the Sample1.DSC 
data file, the data were placed in a worksheet named Sample1dsc, with the Y data in a 
column named cp. Thus the Sample1dsc data set is called Sample1dsc_cp. 

To open the Sample1dsc worksheet 

· Select Sample1dsc from the data list in the Data menu. 

Shortcut to worksheet. Right-
click on the data plot and 
select Open Worksheet from 
the menu. 
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Lesson 1 Basic Data Analysis 

The Plot Details dialog box opens. (Note that you can also open this dialog box by 
double-clicking on the data plotted in the RawDSC plot window). 

· Click on the Worksheet button. 
The Sample1dsc worksheet opens. 

Refer to Chapter 3 Worksheets in the Origin User’s Manual for a complete discussion 
on working with Origin data sets. 

Normalizing the Data 

Before you proceed to fit (deconvolute) the data, you will need to normalize the result by 
concentration. Normalizing the data divides by the number of moles of the sample 
substance in the cell, to convert from cal/degree to cal/mole/degree. Concentration 
normalization is always carried out after subtracting the reference data. 

13 



     

 

     
 
                

 
 

       
    

 
             

             
                  

             
                 
               

 

 
 

 
   

             
              

       
 

 

   
  

   
     

    
 

 

DSC Data Analysis Tutorial Guide 

To normalize Sample1dsc by concentration 

To quickly switch 
between Origin 
windows, press and 
hold down the Ctrl key 
while pressing the Tab 
key. 

· Click on the RawDSC window to make it active, or select RawDSC from the Window 
menu. 

· Click on the Normalize Concentration button. 
A dialog box opens. 

· Enter the sample concentration in mM/L, and the cell volume in ml. 
For this example, enter 0.08 into the Concentration mM/L text box (Sample1.dsc 
was at a concentration of 80 µM/L), and 1.12 in the Cell Vol (ml) text box. (The 
concentration will automatically appear if you originally entered it into the header of 
the raw data file. Cell volume is set in the CELL1.CON file in the folder containing 
the data acquisition program and is stored in the header information of each data file.) 

· Click OK. 
The Sample1dsc_cp data plot is removed from the RawDSC plot window. RawDSC 
closes, and a new plot window, NormDATA, opens. The normalized data are plotted 
as Sample1dsc_cp in the NormDATA plot window. 

14 



      

 

             
 

    

                
                  

        
 
 

     
 
           

               
               

      
 

 
 

               
                

               
     

 
 
 

Lesson 1 Basic Data Analysis 

Note that NormDATA contains two buttons, which are used in the subtract baseline 
procedure. 

Creating a Baseline 

The final step before deconvolution is to start the baseline session and plot a baseline for 
your data. You will then decide whether or not to subtract the baseline and, based on that 
decision, choose from one of three curve-fitting models. 

To start the baseline session 

· Choose the Start Baseline Session command from the Peak menu. 
Based on the normalized data, Origin calculates and plots in red the left and right 
linear line segments from which to determine the baseline. A new menu bar appears, 
containing the baseline session command menus. 

Origin lets you adjust the left and right linear segments, and provides several options for 
connecting the segments to create the baseline. For this example we will simply accept the 
default segments as plotted, and connect them using a progress baseline. For greater detail 
see Lesson 4, Baseline Determinations. 
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DSC Data Analysis Tutorial Guide 

To plot the baseline 

· Select Progress Baseline from the Baseline menu. 
Origin calculates and plots the progress baseline. 

The progress baseline is created such that each point of the baseline in the peak region 
reflects the extent of progress of the reaction. For a single transition such as this, the 
area between the progress baseline and the data approximates the total heat change due 
to the transition. 

· Click OK in the menu bar to exit the baseline session. 
Origin asks if you want to subtract the baseline data. 

· Click YES. 
Origin subtracts the baseline data from the normalized data, then exits the baseline 
session. 
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Lesson 1 Basic Data Analysis 

Fitting the Data 

Origin provides four models with which to fit a curve to your data. All four models use 
the Levenberg/Marquardt (LM) non-linear least-square method. In general, you will want 
to get the best possible fit using the simplest model that fits the data. Curve fitting is 
discussed in greater detail in Lesson 5. This section will serve to acquaint you with the 
basic procedure. 

The four curve-fitting models are located in the DSC menu. They are: 

Model Parameters 

Model 1: 2 State Tm, H 
Model 2: Non 2 State Tm, H, Hv 

Model 3: 2 State w/dCp Tm, H, Cp, BL0, BL1 
Model 4: Dissoc w/dCp Tm, H, Cp, BLO, BL1, n 

All models except model 4 offer three menu-selection options (model 4 offers only a 
Cursor Init option): 

1) Cursor Init -allows cursor initialization of each transition (Tm's). 
2) No Init - accepts the previously defined parameters, if any. 
3) Simulate.. - allows you to create a transition by entering user-defined parameters. 

We will be using only the Cursor Init options in this lesson. 

In the previous section you subtracted a baseline from your normalized data. Models 1 
and 2 require you to subtract the baseline before fitting, while model 3 requires that you 
NOT subtract the baseline. Model 1 is the simplest model, so let's try fitting to this model 
first. 

To fit a curve with the 2-state model (model 1) 
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DSC Data Analysis Tutorial Guide 

· Select 2-State Cursor Init from the DSC menu. 
Origin integrates the Sample1 data, then opens a dialog box asking you to enter the 
number of transitions. 

· You will fit this data with a single Tm, so enter a 1 and click OK. 

· Double-click to set the Tm for this peak. Or click once, use the arrow keys to position 
the cursor, then press RETURN. Set Tm equal to about X = 61. 

Origin initializes the fitting parameters, displays the parameters and Chi^2 in the 
Fitting Session dialog box, and draws an initial fit curve. 

· When initialization is complete, the Attention! dialog box appears with the message 
"Done init with fixed Tm's". 
Click OK. 

The Fitting Session 

You are now in the Basic Mode of the Fitting Session dialog box. Note that a new 
window displays the fitting button commands. Please refer to the Origin User’s Manual 
or press the F1 key for Online help for more information about the fitting procedures. 
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Lesson 1 Basic Data Analysis 

Chi-Sqr Allows the user to change the values of the parameters (i.e. Tm, ΔH) to 
see an update of the fit using the new parameters and Chi^2 is updated. 
This option can be used for a quick simulation of curves. 

1 Iter. One iteration of the Marquardt-Levenberg routine. At the end of the 
iteration the fit curve, fitting parameters, and Chi^2 are updated. 

10 Iter. Same as above, but carries out ten iterations. The number of Iterations 
can be changed in the fitting sessions window by switching to the 
Advanced Mode of the fitting session (click on the More.. button) and 
selecting Options : Control. Then change the Max Number of 
Iterations from the drop down list box. 

Select Function... Opens the Select Function dialog box, which allows the user to 
select a built-in or previously saved function for fitting. 

Select Dataset... Opens the Select Dataset dialog box, which allows the user to 
change the data file for fitting, the temperature range and/or Fitting Step 
Size used to fit the data 

More... Switches from the Basic mode of the curve fitting dialog box to the 
advanced mode which contains its own menu bar for access to more 
options for fitting procedures. 

Done! Exits the Fitting Session dialog box, returns to the NormData window, 
the fit curve is plotted and the fitting results are plotted in the Results 
text window and to a text box in the Normdata window. 
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DSC Data Analysis Tutorial Guide 

· Use the 1 Iter. & 10 Iter. buttons to control the iteration of the fitting cycles, as 
described above. Watch the fitting parameters and Chi^2 update in the Fitting 
Session dialog box. 

To fit a curve with the non 2-state model (model 2) 

· Select Non 2-State Cursor Init from the DSC menu. 

· Repeat the steps you followed above when fitting with the 2-state model. The fitting 
procedure is identical for the two models. 

· Click Done! when finished. A fit curve is generated, and the fitting results copy to the 
Results Window and to a text box in the Normdata Window. Note the difference in 
parameter values between the two models. 

To fit a curve with the 2-state w/dCp model (model 3) 

Model 3 is designed for use with data having a non-zero ΔCp. Model 3 requires that a 
baseline be associated with the data, so first we need to retrieve the baseline we 
subtracted previously. To do so: 

· Select Simple Math from the Math menu. 
The Math dialog box opens. 

· Select Sample1dsc_cp, then click on the upper => button. 
Sample1dsc_cp copies to the Y1 text box. 

· Select SAMPLE1DSC_CP.BASE (this is the original baseline data set), then click on 
the lower => button. 
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Lesson 1 Basic Data Analysis 

SAMPLE1DSC_CP.BASE copies to the Y2 text box. 

· Click in the Operator: text box, and type a "+" in the operator text box. 

· Click OK. 
The original Sample1 data is restored, since the baseline which was subtracted earlier 
has now been added back. 

· Now that you have retrieved the baseline data, go ahead and fit a curve using model 3. 
Select 2 State w/dCp Cursor Init from the DSC menu. Then follow the same steps 
as outlined for the previous two models. Click on Done! to exit the fitting session. 

To format the fitting parameters text 

· Double-click on the text in the plot window. 
The Text Control dialog box opens. 

· Change the text style (for example, change font to Roman, and point size to 10). 
Note that to ensure a true What-You-See-Is-What-You-Get text display on screen, you 
should select the Print View mode from the View menu. View mode does not affect 
output so, for the sake of screen refresh speed, it is usually adequate to use Page 
View, Window View, or Draft View, all of which are faster. 

· Click OK. 

Calibration 
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DSC Data Analysis Tutorial Guide 

We will close this lesson with a brief note about instrument calibration. Every two or 
three months you will want to calibrate the DSC instrument against the Y axis scale in 
Origin. To do this you will fill both cells with water, then key in heat pulses to produce a 
calibration file (as described in your DSC instrument manual). You then open the 
calibration file into Origin, and check that the heat pulses match Origin's Y axis scale 
readings (+/- 1%). Note that the measured peak heights of 9.008, 6.007, and 3.006 
indicated on the figure below agree very closely with experimentally entered pulses of 9, 
6, and 3 mcal/minute. Pulse heights can be readily measured using the data reader tool 
from the Toolbox. One way to do this is to take a reading immediately before the pulse 
and immediately after the pulse, average these two readings, and then subtract the average 
from a third reading taken in the middle of the pulse. 
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When you open a calibration file you must remember not to normalize on scan rate. 
This means you should remove the checkmark from the Scan Rate Normalization 
checkbox in the RawDSC plot window before you read in the data file. If you neglect to 
do this and leave the scan rate normalization on, your calibration results will be wrong. 
Also note that when unnormalized DSC data are read into Origin, the Y axis units are 
mcal/min rather than cal/deg, which is obtained when data are normalized. 

You now know how to perform basic data analysis of DSC files using Origin. The 
following lessons in this tutorial each look at a specific aspect of DSC data analysis in 
detail. You may work through these lessons in any order. 
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Lesson 2 Using the Data Selector Tool 

Lesson 2: Using the Data Selector Tool 

The Data Selector is a toolbar tool that is used to select a segment of plotted data. 
Subsequent math, editing, or fitting operations will be carried out on the selected segment 
only. 

In this lesson you will learn how to select a plot segment, delete the segment, set the data 
plot display range, and reset the display range. A sample DSC data file, 
SAMPLE2.DSC, has been included for your use with this lesson. 

To open the SAMPLE2.DAT data file 

Shortcut: 
Click the New Project 
button on the Standard 
toolbar. 

· Select File:New:Project to open a new project. 

· Click on the Read Data button in the RawDSC window. 
The Import Multiple ASCII dialog box opens. 

· Double-click on Sample2.dsc in the Files list box. 
Sample2.dsc is located in the [Samples] sub-folder of the [Origin50] folder. The path 
and file name will be added to the lower list box. 

· Click OK. 

The Sample2.dsc file opens into the RawDSC plot window. 
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DSC Data Analysis Tutorial Guide 

To select a segment of plotted data 

· Click on the Data Selector tool in the toolbox. 
The Data Selector becomes highlighted. 
The pointer turns into a cross-hair. 
Two data markers appear, one at either end of the Sample2dsc_cp data plot in the 
RawDSC1 plot window. 

· Position the cross-hair on the left data marker, hold down the mouse button, and drag 
the marker to the right, approximately to the position shown below. Or use the arrow 
keys to move the marker: use the Left or Right arrow keys to select a marker; use 
Control + Left or Right to move the selected marker (hold down the Control+Shift 
key to increase the speed). 

PLEASE NOTE: If you are using the mouse to move the left cursor you must be 
directly on the marker before you click and drag the marker, if the mouse cursor 
is away from the left cursor and you click and drag the mouse the RIGHT 
marker will be positioned at the mouse cursor. To return the right marker to the 
desired position click and drag the mouse at the old position. 
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Lesson 2 Using the Data Selector Tool 

· To set the markers, double-click in the plot window, press Return (pressing the escape 
key with your left index finger is equivalent to pressing Return and this allows you to 
keep your right hand on the mouse), or click on any toolbar tool. 
The markers are set, and the Pointer tool is re-selected (unless you selected a different 
tool). 

Any math, editing, or fitting operation now performed will affect only the selected plot 
segment. For example, you could delete the segment. 

To delete the selected plot segment 

· Choose Cut or Clear from the Edit menu, or press the Delete key. 
The selected plot segment is deleted from the plot window. The selected values are 
also deleted from the SAMPLE2 worksheet. 
The data markers are removed. You may select Edit:Undo to replace the data. 
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DSC Data Analysis Tutorial Guide 

Data markers are only meant to be displayed temporarily. They will disappear as soon as 
another data set or plot window becomes active. To select a segment of data for a longer 
period of time, use the Set Display Range command. 

Say that you would like to display or manipulate a central range of data in the SAMPLE2 
data plot, but you do not want to delete any of the data. This is an ideal use for the Set 
Display Range command. 

To set data plot display range 

· Click on the Data Selector tool, click on the right data marker, and position it as shown 
below. Then click on the left data marker, and position it as shown: 

· Double-click or press Return to set the markers. 

· Choose Set Display Range from the Data menu. 
The data outside the selected range are hidden from view. 
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Lesson 2 Using the Data Selector Tool 

You may expand your data to fill the plot by selecting Graph: Rescale to Show All if 
you wish. All math, editing, and fitting operations will be done on the display range only. 

The data outside the display range are not deleted; they are merely hidden. Use the 
Reset to Full Range command to bring the hidden data back into view. 

To reset display to full range 

· Choose Reset to Full Range from the Data menu. 
Origin resets the data markers so as to display the entire curve. 
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Lesson 3 Integration 

Lesson 3: Integration 

If you have created a baseline for a DSC data plot, you can select a range of data to 
integrate. Integration yields the following information about the data: integration range, 
temperature range, area, thermal midpoint, and width of curve in degrees C at half height. 
In this lesson you will use the Data Selector tool to set the integration range, integrate 
the data, copy the integration results to the plot window, and plot the integration data. 

Setting Range and Integrating the Data 

As you saw in Lesson 2, all math, editing, and fitting operations are performed on the 
currently selected plot segment or on the current display range. This is true for 
integration as well. The first step in integration is to use the Data Selector to set the 
integration range. If you do not set the integration range, the entire display range will be 
integrated. 

Before beginning this lesson, open a new project: 

· Select the File:New:Project (or click on the New Project button) command. 

· Click on the Read Data button in the RawDSC1 plot window. 
The Import Multiple ASCII dialog box opens. 

· Double-click on Sample1.dsc (located in the [Samples] sub-folder of the [Origin50] 
folder). 

· Click OK to plot the files from the lower list box. 
SAMPLE1.DSC opens into the RawDSC plot window. 
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Before integrating, you must plot a baseline for the data. You will then choose to either 
integrate from the baseline, or subtract the baseline and integrate from zero (see Lesson 4 
for more about baseline determinations). 

Plotting a baseline 
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DSC Data Analysis Tutorial Guide 

· Select Start Baseline Session from the Peak menu. 
Origin starts the baseline session, and plots two red linear baseline segments. 

· Select Progress Baseline from the Baseline menu. 
Origin connects the linear segments with a progress baseline. 

· Select OK from the menu bar. 
Origin asks if you want to subtract the baseline. Click No. 
Origin exits the baseline session. 
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To set the integration range 

· Click on the Data Selector tool in the toolbox. 
Two data markers appear on the SAMPLE1 curve (note that these appear on 
SAMPLE1, and not on the baseline curve, because SAMPLE1 is currently set as the 
active data plot in the Data List, under the Data menu). 

· Using the mouse or the arrow keys, position the data markers approximately as shown 
below. (If you are not sure how to position the markers, refer to Lesson 2 in this 
tutorial.) 

· Double-click or press Return to set the markers. 
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Lesson 3 Integration 

The area between the markers is the range that will be integrated. 

To integrate the selected range 

· Since you have created a baseline but have not subtracted it from the data, integrate by 
choosing Integ from Baseline from the Peak Menu. 

If you had subtracted the baseline from the data, you would integrate by choosing 
Integ from 0 from the Peak menu. 

The area between the two data markers is integrated. The integration results copy to the 
Script Window. 

If you wish, you can reset the markers and try again. Each time you integrate, the results 
are pasted to the Script Window. To clear the integration shading from the plot window, 
select Refresh from the Window menu. 

The procedure that copies the integration results to the Script Window is a macro called 
EndInteg. EndInteg is defined in the DSC.CNF file, and can be redefined to customize 
the output to suit your needs. For more information see the LabTalk Reference Manual, 
available separately from MicroCal. 

Displaying the Integration Results 

The Script Window is a full-featured text editor. Use it to edit the integration text, save 
the text to a file, or copy and paste the text with the clipboard. 

To copy the integration results to the plot window 
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DSC Data Analysis Tutorial Guide 

· Click and drag with the mouse to highlight the integration results in the Script 
Window. 

· Choose Copy from the Script Window Edit menu. 
The text is copied to the clipboard. 

Alernatively, to copy and paste, you 
may right-click on the highlighted 
text, select copy from the menu, then 
right-click where you want to 
position the text label and select 
paste. 

· Choose Edit:Paste from the menu bar along the top of the Origin project window. 
The integration text is pasted to the RawDSC1 plot window (the active window). 

The text as pasted is too large and placed poorly. Let's reformat and reposition the text, 
and add a text border. 

To change the text style 

· Double-click on the integration results text in the plot window. 
The Text Control dialog box opens. From here you can edit the text, set font style, 
color, and point size, rotate the text, and add a border. 
Note that the Text Control dialog box is divided into two display boxes all text entries 
and formatting is done in the upper text box, the lower text box displays the text as it 
will actually appear (WYSIWYG) in the graph window. 

· Type 12 into the center points text box. 

· Select Black Line from the Background drop down list box. 
Note that if you select none for the Background the box may not be erased till you 
perform a screen refresh (select Window:Refresh). 
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Lesson 3 Integration 

· Click OK. 
The Text Control dialog box closes, and the integration results text updates to show 
your changes. 

· Click and drag on the integration results text to place the text in the upper right corner 
of the plot window. 

To see the graph exactly as it will appear when printed, switch to the Print View view 
mode. View mode is chosen from the View menu. 

To change view mode 

· Click once on the View menu. 
The View menu commands appear. Notice that Page View is checkmarked, showing 
it to be the selected view mode. Page View uses the screen driver to display font 
information. 

· Select Print View from the menu. 
Print View is now the selected view mode. Print View gets font information directly 
from the printer driver, and is a true WYSIWYG view mode. 
The plot window text is now sized and positioned correctly. 

• Before proceeding with this lesson, re-select the View:Page View command. 

For more about view mode see Chapter 12: Plotting: Customizing the Page Display in the 
Origin User’s Manual or select the Index tab from the Help:Origin menu option and 
enter View mode into the upper text box. 

To remove the data markers 

· Select Data Markers from the Data menu (to remove the check mark). 
Origin hides the data markers. 

Plotting the Integration Area Data 
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DSC Data Analysis Tutorial Guide 

The integration area data is saved (as a function of X, which is temperature for 
calorimetric data) into a data set named _integ_area. The leading underscore signifies 
that _integ_area is a temporary data set which will be deleted whenever memory is 
running low. To access the worksheet of _integ_area data, or use it for any other 
purpose, you should first copy _integ_area to a permanent data set. 

To copy the integration area data to a new data set 

· Click on the Edit menu in the Script Window menu bar. Note that the Script 
Execution command is checkmarked, which means you can currently execute 
LabTalk scripts directly from the Script Window. 

· On a new line, type the following script exactly as it appears. Be sure to include the 
single space before _integ_area and also before my_test: Please note that the data 
set name must consist of two parts separated by the underscore character. The first 
part will be the worksheet name (in this case the worksheet will be named my) the 
second part will be the column name of the data set. 

copy _integ_area my_test 

· Press Return. 
Origin should append a semicolon " ; " to the text you just entered. This indicates that 
the script was executed. For more information about the Lab-Talk scripting language, 
please refer to the LabTalk manual or select the online Help:LabTalk menu option. 

My_test is now an Origin data set that can be plotted and manipulated like any other 
data set. 

To plot the my_test integration area data 

· Select File:New:Graph to open a new plot window. 
The Graph1 plot window opens. 

Shortcut: · Double-click on the layer icon in the Graph1 plot window. 
Click on the The Layer Control dialog box opens. 
New Graph 
button · Click on my_test in the Available Data list, then click on the => button. 

My_test appears in the Layer Contents list. All data sets in the Layer Contents list 
will plot in the active layer. 
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Lesson 3 Integration 

· Click OK. 

The Layer Control dialog box closes, and my_test plots as a line graph in the Graph1 
plot window. 
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Lesson 4 Baseline Determinations 

Lesson 4: Baseline Determinations 

Origin creates a baseline for the reaction heat data by establishing a left linear segment 
and a right linear segment that are considered to be the "baseline region". Several 
methods can be used to connect these two segments to form the baseline. In this lesson 
you will learn how to create, format, subtract, and open the related worksheet for a 
baseline. You will also learn about the various baseline creation options that are 
available. 

Baseline commands are located under the Peak menu. 

Starting the Baseline Session 

When you are ready to create a baseline for your data, you must start the baseline 
session. In this lesson we will create a baseline for the SAMPLE1 DSC data file. 

To open the SAMPLE1 data file 

Shortcut: You can 
program Origin to 
always Look in: the 
Samples folder (or any 
other folder) by selecting 
File:Set Default Folder 
and entering a new path 
in the text box 

· If you are continuing from a previous lesson, first select File:New:Project (or click on 
the New Project icon) to open a new Origin project. 

· Click on the Read Data button in the RawDSC plot window. 
The Import Multiple ASCII dialog box opens. 

· Double-click on Sample1.dsc in the Files list. 
SAMPLE1.DSC is located in the [Samples] sub-folder of the [Origin50] folder. The 
path and file name will be added to the lower list box. 

· Click OK. 

SAMPLE1 opens into the RawDSC plot window. 
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DSC Data Analysis Tutorial Guide 

Before creating the baseline, you would normally subtract reference data, and then 
normalize the data on concentration. For the sake of brevity, we will bypass those steps 
here. They are discussed in detail in Lesson 1, Basic DSC Data Analysis. 

To start the Baseline Session 

· Choose Start Baseline Session from the Peak menu. 
Origin enters the baseline session, and automatically analyzes the data to determine the 
linear segments to be drawn on either side of the peak 

Note that a new command menu bar now appears at the top of the project. These 
command menus provide complete control over the baseline determination process, as 
follows: 

OK Accepts the current baseline, provides an opportunity to subtract this 
baseline from the data curve, and then exits the baseline session. 

Adjust Allows the user to adjust the two linear segments. 

Baseline Choose one of five options for creating a baseline, or draw a baseline 
manually. 

Cancel Exits the baseline session unconditionally. The current baseline, if any, is 
deleted. 

If you are having difficulty seeing the linear segments, you can maximize the plot window 
for a better view. 

To maximize the RawDSC plot window 

· Click on the Maximize button, at the upper-right corner of the window. 
The window zooms to full size. 
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Lesson 4 Baseline Determinations 

User Adjustment of Linear Segments 

If you are not satisfied with the two automatically determined linear segments, use the 
Adjust menu to change the segments as you see fit. The Adjust menu provides two 
options: refit the segments, or move the segments by cursor. 

To refit the linear segments 

· Choose Refit Right Segment from the Adjust menu. 

· Click the cross-hair on or near the data you want as the first point of the linear segment. 
A red cross appears on that point. 

· Use the left and right arrow keys to move the red cross, until you have selected the 
point you want. 

· Press Return. This sets the selected point as the first point of the linear segment. 

· Repeat the previous three steps to select the last point of the linear segment. Origin 
now generates a new linear segment by fitting the data between the two points to a 
straight line. 

Now for the left linear segment. Instead of using the refit command, lets adjust the left 
segment by cursor. 

To move linear segments by cursor 

· Select Move Segments by Cursor from the Adjust menu. 

· Select and move one of the left segment end points by either: 

- Clicking on one of the terminal black squares and dragging the mouse, or 

- Selecting an end point with the LEFT or RIGHT arrow keys, then using the UP and 
DOWN arrow keys to move the point up or down. Use the CONTROL + LEFT or 
CONTROL + RIGHT arrow keys to move the point left or right. 

· Repeat the previous step for the other segment end point. 

· When you are satisfied with the placement of the left linear segment, double-click in the 
plot window, or press the Return key. 
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DSC Data Analysis Tutorial Guide 

Choosing a Baseline Option 

Once you have set the linear segments, you are ready to select one of the six options for 
creating a baseline. You will find the baseline options in the Baseline menu. 

To select an option for creating the baseline 

· Click on the Baseline menu option. 

· Choose a baseline option from the menu. 

· When you are satisfied with the baseline, click on the OK command in the menu bar to 
exit the baseline session. Origin gives you the opportunity to subtract the baseline, 
then returns you to the RawDSC window (or, if you had normalized the data, the 
NormDATA plot window). 

The six baseline options are described in detail below. 

Progress Baseline 
In this option, the baseline in the peak region is created such that each point reflects the 
extent of progress of the reaction. That is, the placement of a baseline point at any 
temperature in the transition region (i.e., relative to the left and right baseline extrapolated 
to the same temperature) is determined by the fraction of the total area that has been 
completed at that temperature. The progress baseline for the SAMPLE1 data is shown 
below: 
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Lesson 4 Baseline Determinations 

For a single transition such as this, the calculated baseline then approximates the molar 
heat capacity for the mixture of the states as they exist at any temperature in the transition 
region. The area between this baseline and the data then approximates the total heat 
change due to the transition. 

Note that only the slope and intercept of the linear segments are used in the calculation 
for the progress baseline. The actual end points of the linear segments are not used. 

During the calculation of a progress baseline, Origin integrates over the entire display 
range of the active data set. If you prefer, you can restrict the region of integration to just 
the peak area. After adjusting the low and high temperature linear baseline segments, use 
the Data Selector tool (described in Lesson 2) to set the region where integration should 
be carried out. If you now select the Baseline:Progress Baseline command, integration 
will be restricted to the region that lies between the two data markers. 

Linear Connect 
This baseline is formed by connecting the two linear segments with a straight line, as 
shown below: 

Whereas the progress baseline uses only the linear segment slope and intercept to form 
the baseline, linear connect uses only the position of the two end points. 
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DSC Data Analysis Tutorial Guide 

Cubic Connect 
Similar to Linear Connect, except the connection is a cubic polynomial. The end points 
are used to create the baseline, as with Linear Connect, but with Cubic Connect the slope 
is used also: 

Step Baseline 
There are two step baseline options. Step at Peak is based on a linear connect baseline, 
and places the step directly under the peak. Step at Half Area places the step at the 
position of half the integrated area: 

Move Baseline by Cursor 
This option lets you manually adjust the baseline by specifying the position of each of the 
baseline data points. 

To use the Move Baseline by Cursor option, first create a baseline by selecting one of 
the baseline creation commands described above. Next, select Move Baseline by Cursor 
from the Baseline menu. Origin places twelve data points along the baseline you just 
created. To move the data points either click and drag with the mouse, or use the left and 
right arrow keys to select a point, and the up and down arrow keys to move the selected 
point (points can only move vertically). 

When you are satisfied with the baseline, double-click or press Return. A spline 
connection option is automatically applied to the new baseline. You can remove the 
spline connection by changing the baseline's plot display options (see page 42, below). 
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Lesson 4 Baseline Determinations 

Cursor Draw Baseline 

Cursor Draw Baseline is another method for creating a baseline. The Cursor Draw 
Baseline method does not require you to enter the baseline session, set linear segments, or 
select a baseline option. In this method, you simply draw the baseline directly in the plot 
window. 

To use the Cursor Draw Baseline option 

· If you have not yet exited the baseline session, do so now by clicking OK or Cancel in 
the baseline session menu bar. 

· Select Cursor Draw Baseline from the Peak menu in the standard menu display bar. 
The cursor changes to a small cross-hair. 

· Double-click with the mouse to place each baseline point. Each point connects to the 
next with a straight line. The XY coordinates of the point appear in the Data Display 
Tool. You can place any number of points you wish. 

· You can also use the arrow keys to place points. Click once with the mouse to place a 
cross-hair on the screen. Use the UP, DOWN, LEFT, and RIGHT arrow keys to 
move the cross-hair. Press RETURN to set the position of a point. 

· When you are satisfied, click on the Pointer tool in the toolbox to set the baseline. 

Once you have created a baseline, you can use the Adjust Baseline option to fine-tune 
the default baseline. 

To adjust the baseline 

· Select Adjust Baseline from the Peak menu. 
The pointer becomes a cross-hair. 

· To adjust a baseline point, click and drag with the mouse. Or use the arrow keys (select 
a point with LEFT or RIGHT arrows; move up and down with the UP or DOWN 
arrows; move left and right with CONTROL + LEFT or CONTROL + RIGHT 
arrows). 

· When you are satisfied, double-click on a data point or press Return to set the baseline. 

The baseline points in Cursor Draw Baseline and Move Segments by Cursor connect 
with a straight line by default. Connect type (and other display options) can be changed 
by double-clicking on a point in the baseline and selecting new options in the Plot Details 
dialog box. 
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To change connect type for a baseline 

· Double-click on the baseline. 
The Plot Details dialog box opens. 

· Select a connection option (e.g., spline, straight, step) from the Connect drop down list 
box. 

· Click OK. 

To subtract the baseline from the DSC data 

· Select Subtract Baseline from the Peak menu. 
The baseline is subtracted. 

Each time you create a baseline, Origin names the baseline data set and appends a column 
to the active dataset worksheet for the baseline data. The baseline data set is given the 
name NAME.BASE (NAME.DRBASE in the case of Cursor Draw Baseline) where 
NAME is the name of the data set for which you created the baseline. To see the baseline 
data, open the associated worksheet. 

To open the worksheet containing baseline data 

· Double-click on the baseline to open the Plot Details dialog box, or select the baseline Shortcut to the Worksheet: 
name from the Data menu, then select Plot from the Format menu to open the Plot Right-click anywhere on the 
Type dialog box. data trace and select Open 

Worksheet from the drop 
· Click on the Worksheet button. down menu. 

The baseline worksheet opens. 
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Lesson 5 Curve Fitting 

Lesson 5: Curve Fitting 

In Lesson 1 we discussed Origin's basic curve fitting procedures. Here we will look at 
the curve fitting process in greater detail. In the first section below, we will make some 
general observations about the curve fitting models used in Origin. Following that, we 
will work through two fitting examples to illustrate some of the flexibility of the curve 
fitting process. 

General Comment 

Origin provides four models with which to fit a curve to your data. All four models use 
the Levenberg-Marquardt non-linear least-square method, but differ in the number of 
parameters involved, as shown below: 

Model Parameters 

Model 1: 2-State with zero DCp Tm, H 
Model 2: Non-2-State with zero DCp Tm, H, Hv 

Model 3: 2-State with non-zero DCp Tm, H, Cp, BL0, BL1 
Model 4: Dissoc with non-zero DCp Tm, H, Cp, BL0, BL1, n 

Tm is the thermal midpoint of a transition; H is the calorimetric heat change (ΔH); Hv is 
the van't Hoff heat change (ΔHv); Cp is the ΔCp for each transition; BL0 and BL1 define 
the slope and intercept of the low-temperature baseline segment; and n is the number of 
sub-units 

All of the models except model 4 can be used to fit to one or more transitions. In the case 
of multiple transitions, each transition has its own complete parameter set; e.g., if model 1 
is used to fit two overlapping transitions there will be two independent parameter sets 
[Tm1, H1] and [Tm2, H2]. These specify the thermal midpoint (Tm) and the heat change 
(ΔH) at the Tm for each transition. The BL0 and BL1 parameters are an exception to this 
rule. These parameters appear only once in the model; they are not repetitive for each 
transition. 

While all four models use a calorimetric heat change (ΔH), only the non-2-state model 
(model 2) has a van't Hoff heat change (ΔHv). The calorimetric heat H is determined only 
by the area under a transition peak, while the van't Hoff heat Hv is determined only by the 
shape of the transition peak. The sharper the transition, the larger is Hv, and vice versa. 
The relationship between H and Hv can sometimes provide insights not accessible from H 
alone, For example, if a protein is composed of two identical domains which unfold 
independently with the same Tm and H, then the ratio of H/Hv will be 2.0, while it would 
be 1.0 if the protein had only a single domain. If, on the other hand, the protein dimerized 
and the dimer underwent only a single coupled transition then the H/Hv ratio would be 
0.5. It is clear from this that the calorimetric heat H refers to heat change per mole while 
Hv is heat change per unfolding unit (called the cooperative unit). Thus the ratio H/Hv 

can, in simple cases, be thought of as the number of cooperative units per mole. 

(Note: It is important to realize that the ratio of calorimetric to van't Hoff heat depends 
on concentration normalization, since calorimetric heat is always expressed on a per mole 
basis. Thus for the protein dimer example considered above, the ratio will be 0.5 if 
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DSC Data Analysis Tutorial Guide 

concentration normalization is carried out on a per mole of monomer basis while it will be 
1.0 if concentration is entered in terms of moles of dimer present.) 

In model 1, it is possible to prescribe that overlapping transitions are either 
independent or sequential in nature. For example, if two structural domains are 
interacting strongly, it is possible that their transitions will be coupled in a sequential 
manner, whereas the independent model might better describe two transitions which are 
completely uncoupled from one another. In practice, this choice is often not critical since 
the sequential and independent models lead to virtually identical results whenever the 
Tm's of two transitions are separated by a couple of degrees or more. To switch between, 
select the DSC:Set Indep/Sequ Model command and answer the prompt that appears. 

Origin provides the option to float all parameters during the fitting procedure, or to 
assign some parameters as fixed and float others. In fixing a parameter, it may be given 
an invariant numerical value. 
The mathematical derivations for each model are included in the appendix. In general, 
the objective of most investigators is to use the simplest model (e.g., fewest floating 
parameters) which provides a good fit of the data. Thus, if data are satisfactorily 
described by the two-state model using two transitions, this is to be preferred over a two-
state model with three transitions or a non-two-state model with two transitions. It is 
usually only when a given model is unable to fit the data that complexity should be 
increased by adding more fitting parameters. 

Fitting Example 1 

To better understand the flexibility of Origin's curve fitting process, work through the 
following example. The example uses data from a protein of structure ABA, i.e., two 
identical and non-interacting A domains and a single B domain. Head-to-head 
covalently-linked dimers can readily form ABA type of structures. By comparison of 
results from different fitting models, structures of this type can be recognized from DSC 
data. 

If you are continuing from the previous lesson, first select File:New:Project (or click on 
the New Project button) to open a new project. 

Step 1: Prepare the data 

The first step in any fitting procedure is to open the DSC data file and reference data file, 
then prepare the data by subtracting reference data and normalizing the result on 
concentration. We have dealt with these data preparation procedures in Lesson 1 of this 
tutorial. Here we will briefly review the steps involved: 

1) Click on the Read Data button in the RawDSC window, and open the 
SAMPLE5.DSC and REF5.DSC data files (located in the [Origin50][Samples] 
folder). 

3) Click on the Subtract Reference button. The Subtract Reference Data dialog box 
opens. 

4) Select Sample5dsc_cp for the Data drop down list box entry. 
5) Select Ref5dsc_cp for the Reference drop down list box entry. 
6) Click OK to subtract Ref5dsc_cp from Sample5dsc_cp. 
7) Click on the Concentration Normalization button. 
8) Enter 0.074 mM/L and 1.22 ml in the dialog box, and click OK. 
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Lesson 5 Curve Fitting 

After completing these eight steps, your screen will show the normalized SAMPLE5 data 
plotted in the NormDATA plot window. 

It is important to remember that data must always be normalized on concentration before 
doing curve fitting to any of the fitting models. 

Step 2: Plot a baseline 

As we have discussed elsewhere in this tutorial, the next step is to plot a baseline for the 
data. Note that the SAMPLE5 plot shows flat baseline segments on either side of the 
transition, with a ΔCp in between. The transition itself actually starts and ends at about 
the positions shown by the arrows below: 

To create a good progress baseline for this data, you may wish to manually adjust the 
linear baseline segments so that they are parallel to each other, and coincident with the 
baseline data. Origin does not use the position of the endpoints of the linear segments to 
calculate the progress baseline, only the slope and offset. You are thus free to create 
linear segments of any length, which makes it much easier to align the segments parallel 
to each other. 
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DSC Data Analysis Tutorial Guide 

To create the baseline: 
1) Select Peak:Start Baseline Session... 
Origin calculates and draws the two linear baseline segments, faintly visible in the figure 
below: 

2) Select Adjust:Move Segments by Cursor. 
3) Beginning with the left linear segment, click and drag on first the left and then the 
right endpoint until the graph looks approximately like the figure below (you can also use 
the arrow keys to move an endpoint. Use the Up and Down arrows to move up or down, 
Control+Left and Control+Right arrows to move left and right, and Right and Left 
arrows to select a new end point): 

4) Now use the cursor to adjust the right linear segment as follows: 
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Lesson 5 Curve Fitting 

5) Select Baseline:Progress Baseline. 
Origin plots a progress baseline. 

6) Select OK from the menu bar. 
7) Click Yes in the dialog box to subtract the progress baseline. 

Your graph should now look like this: 

Step 3: Fit to the least complex model 

Generally, you will want to use the simplest model (e.g., with the fewest floating 
parameters) that provides a good fit to the data. You can then add complexity if 
necessary. Begin the fitting session by using model 1 (2-state with zero ΔCp) to fit the 
data. To do so: 

1) Select 2-State Cursor Init from the DSC menu. 
This starts the fitting session, with model 1 selected. The Cursor Init option allows you 
to initialize the parameters, rather than accept any existing parameters. 
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DSC Data Analysis Tutorial Guide 

2) Origin prompts you to enter the number of transitions. The simplest fit would be to 
two transitions, so enter a 2 and click OK. 
3) Double-click on or near each peak to set a Tm (thermal midpoint) for each transition. 

As soon as you set the Tm's, Origin initializes the fitting parameters (in this case Tm1, H1, 
Tm2, H2), displays the parameters in the Fitting Session dialog box, and draws an initial 
fit curve. An Attention! dialog box notifies you when initialization is complete. Click 
OK to proceed with the fitting. 

4) The 1 Iter. and 10 Iter. commands let you control the iteration of the fitting cycles. 
Click on the 10 Iter. button a couple times. Origin iterates the fitting cycle until the 
change in Chi^2 between two successive iterations is less than a pre-set value (this value 
is determined by the value set in the Tolerance Text box of the Control Parameters dialog 
box, MicroCal has set the default value to be 10-5). Select 10 Iter. once or twice more. 
At the end of each fitting cycle Origin updates the Chi^2 and fitting parameters values 
and draws a new fit curve. 
By now you should have a pretty good fit to the 70 degree peak, but the fit to the 60 
degree peak is not so satisfying. At this point you can begin to think about improving the 
fit by adding complexity to the model. 

Step 4: Add complexity 

You did not get a good fit using model 1 with two 2-state transitions. While the high 
peak fit pretty well, the low peak did not. This could mean that the low peak is not really 
a single peak, but two smaller, overlapping peaks that combine and obscure each other. 
To test this hypothesis, see if you can get a better fit using model 1 and three transitions: 

1) Click on the Close button located in the upper right corner of the Fitting Session 
dialog box to abort the current fit. 
2) Select 2-State Cursor Init from the DSC menu. 
3) Type 3 in the "Number of peaks" dialog box, and click OK. 
4) Double-click to set each of the three Tm's, one for each transition. Place the first Tm 
just to the left of the low peak, the second just to the right, and center the third on the high 
peak. 

50 



    

 

 
 

              
             

 
                     

              
        

 

   

 
           

                    
                

            
            

    
 

                 
              

              
            

             
            

         
 

               
              

                 
      

Lesson 5 Curve Fitting 

Upon setting the third Tm Origin calculates all three sets of fitting parameters (six 
parameters in all, two for each transition) and displays the initial fit curve. 

5) As before, select 10 Iter. from the menu bar to fit the curve to the data. After several 
fitting cycles, you should get a pretty good fit, implying that the three-transition model 
describes this data better than the two-transition model. 

Fitting Example 2 

For multisubunit proteins, it often happens that the subunits dissociate simultaneously 
with the unfolding of the protein, i.e., An = nA, where n is the number of subunits. When 
this happens, the shape of the DSC peak is broadened relative to unfolding of the same 
protein where no dissociation occurs (e.g., covalently linked subunits). The mathematics 
for curve fitting to systems which undergo simultaneous unfolding and dissociation are 
included in the Appendix. 

You may wish to try fitting the data set in the Origin project Dissoc.OPJ, contained in the 
[Origin50][Samples] folder. The data was obtained on a helical polypeptide thought to 
contain two identical chains linked together in a coiled-coil state. These data have 
already been normalized on concentrationand a progress baseline has been created, so 
curve fitting may begin immediately. (Note that whenever using the dissociation model, 
the concentration used for data normalization should be that for the associated low-
temperature state, not that for the dissociated high-temperature state.) 

1) To open Dissoc.OPJ, click Done to exit the fitting session, then select File:Open, 
navigate to the [Samples] sub-folder of the [Origin50] folder, then double-click on the file 
name in the Files list. Dissoc.OPJ opens to show the lv2p0.cp data set with its associated 
baseline plotted in the NormDATA window: 
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DSC Data Analysis Tutorial Guide 

2) Select fitting model 4, Dissociation w/dCp, Cursor init from the DSC menu. 

3) Step 2 may have caused an error message to appear, warning you that no baseline is 
selected for this data. If this happened, you need to let Origin know that you want to use 
the baseline supplied with this data, which is named lv2p0_cp.base. To do this, select the 
Peak : Cursor Pick Baseline command, then double-click on the plotted baseline data. 
When you have finished, again select Dissociation w/dCp, Cursor init from the DSC 
menu. 

4) Select 2 as the Number of Subunits. 

Note that the number of subunits n and the concentration Ct appear in the Fitting 
Function dialog box as non-floating parameters. 

5) Assign value of 0 to the BL0 and BL1 parameters and remove the checks from each 
Vary? Box so the low temperature baseline is not allowed to float. Click on 10 Iter a 
couple of times. You will note that the overall fit curve is fairly good. 
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Lesson 5 Curve Fitting 

6) Now, change the value of n from 2.0 to 1.0. Click on 10 Iter several times. Note that 
the new fit curve is much worse than the original fit curve (Chi^2 is ca. Five times larger) 
and that the experimental data curve is now substantially broader than the fit curve. This 
means the data are most consistent with the idea that dissociation into subunits occurs 
simultaneously with unfolding for this polypeptide. 

7) Change the value for n from 1.0 to 4.0 and fit the data again. It is again obvious that 
the fit is not as good as the original fit using an n value of 2.0, which suggests that the 
polypeptide is morre likely to contain two dissociable subunits rather than four. 

53 



     

 

   

             
                 

               
            

 
     

 
             

              
                 

               
       

 
               

       
 

 
 

       
 

 

DSC Data Analysis Tutorial Guide 

Fitting Example 3 

The Absolute Cp button will facilitate calculation of Absolute heat capacities for proteins 
(this is discussed in more detail in Appedix IV, starting on page 70. To illustrate the 
function of this button there are 5 raw data files of chymotrypsinogen solutions at five 
different concentrations covering a 10-fold range from 0.258 to 2.58 mg/ml. 

Step 1: Input the data 

The 5 raw data files used for this example are Vcht9bs.dsc, Vcht15bs.dsc, Vcht12bs.dsc, 
Vcht13bs.dsc and Vcht14.dsc. The concentration of the sample in each scan is .258, 
.516, 1.03, 1.55 and 2.58 mg/ml, respectively. The samples were run on a VP-DSC at 60 
deg/hr using the passive response mode for each scan. A buffer-buffer reference trace has 
already been subtracted from each data scan. 

1) Click on the Read data button in the RawDSC window and open the Vcht9bs.dsc, 
Vcht12bs.dsc, Vcht13bs.dsc, Vcht14bs.dsc and Vcht15bs.dsc data files. 

Your Origin graph will look like below. 
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Lesson 5 Curve Fitting 

Notice the square around the line type of the last file opened (in this case data set 
Vcht15bs.dsc) in the legend of the graph. This indicates it is the active data set. When 
you click on the Absolute Cp button the routine will convert this data set. 

Step 2: Converting raw data to absolute heat capacity values. 

1) Click on the Absolute Cp button. 

The Absolute Cp dialog box will open with the following default parameters. 

2) For this example all the default parameters are correct1, Click OK. 

1 Literature value for the partial specific volume of chymotrypsinogen is .717 ml/gm, and the coefficient of 
volume expansion is 7x10-4 deg-1 . 
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A new window named AbsCp will be created. With the converted data plotted as shown 
below. 

3) Now hold down the Ctrl key and press the tab key once to switch back to the 
RawDSC window. 

4) Click on the next data set in the legend to make it the active data set. 

5) Click on the Absolute Cp button again. 

Repeat steps 1 – 4 for each data set till you have completed the data conversion for all 5 
data sets. Your graph should now look like below. 
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Lesson 8: Other Useful Details 

Lesson 8: Other Useful Details 

χχχχ2 (chi-sqr) Minimization 

The aim of the fitting procedure is to find those values of the parameters which best 
describe the data. The standard way of defining the best fit is to choose the parameters so 
that the sum of the squares of the deviations of the theoretical curve(s) from the 
experimental points for a range of independent variables is at a minimum. For the ITC 
models, where there is no weighting, the theoretical models can be represented by: 

y = f ( x ; p 1 , p 2 , p 3 ,...) 

where: 
pi = the fitting parameters 

the expression for χ2 simplifies to : 

2 1 2 χ = �[y − f (x ; p , p ,... )] 
eff i i 1 2 n − p 

where: 

neff = the total number of experimental points used in the fitting 

p = total number of adjustable parameters 

yi = experimental data points 

f(x;p1,p2,p3,…) = fitting function 

Note: the difference d = neff - p is usually referred to as the number of degrees of freedom. 

The above equation states that the Chi squared value of the fit is equal to the sum of the 
squares of the deviations of the theoretical curve(s) from the experimental points 
divided by the number of degrees of freedom. Since there is no weighting, it can be 
seen that the calculated values are dependent on the magnitude of the scale and the 
number of data points 

Response Time – VP-DSC 

The VP-DSC is the first calorimeter to have operator-selectable response time. It is made 
possible by passage of the amplified ΔT signal (temperature difference signal between the 
two cells) into the computer for digital processing before the feedback voltage is returned 
to provide feedback power to the sample cell. This allows software control of the gain 
(the ratio of power applied to the sample cell relative to the magnitude of the ΔT signal) 
which in turn controls the response time of the instrument to heat effects occurring in the 
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cells. The passive mode with zero gain is best to use for studying systems having very 
slow transients (broad transition peaks, slow scan rates, or isothermal studies) since the 
baseline is quieter and more stable due to the absence of feedback noise. For systems 
with fast transients (sharp thermal transitions and/or fast scan rates), shorter response 
times must be used to avoid distorting the shape of the thermogram even though this will 
result in lower sensitivity. In the current version of VPViewer, there are four response 
time selections in the experiment set-up window No-Gain (Passive), Low-Gain, Mid-Gain 
and High-Gain, with respective relaxation time constants of 40.9, 18.0, 10.4 and 5.6 
seconds. The respective designations in the header of the data files are 0 (Passive), .5 
(Low-Gain), .75 (Mid-Gain) and 1 (High-Gain). 

Some protein transitions, as well as those of polynucleotides, are fairly sharp on the 
temperature axis so that detectable peak broadening may result when using the passive 
mode at usual scan rates. In such a case, faster response times or slower scan rates may 
be used to improve peak resolution in real time. However, Origin contains a Response 
Time button, which when activated quickly removes small amounts of response-time 
broadening for any of the four response times. This post-run capability sometimes avoids 
the necessity of introducing extraneous noise associated with faster response times, as 
well as allowing the operator to quickly determine if peak resolution is satisfactory for 
any data set. Whenever peak broadening is severe, however, this post-run correction will 
not be completely accurate. 

To illustrate the functionality of the Response Time button we have included the Origin 
project ResponseT.opj in the C:\Origin50\Samples directory. This Origin project 
contains the results of two successive experiments run on a sample at 60 deg/hr. The first 
experiment was scanned using the Passive FeedBack mode, the scan was repeated using 
the High-Gain Mode. The data was scanrate normalized and a baseline has been 
subtracted from each trace. 

· Select File:Open. 

· Navigate to the [Origin50][Samples] directory , double –click the project name 
ResponseT.opj. The project will open as shown below. 
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Lesson 8: Other Useful Details 

You may see from the that the data collected in the passive mode (dashed line) has a 
slightly higher Tm and is slightly broadened from the data collected at the High-Gain 
FeedBack mode (fastest response time). 

· Make sure the data set Vcht20b2ds_cp is the active data 
set (box in legend is around the dashed line type of the 
Vcht20b2ds_cp data set). 

· Click on the Response Time button. The Response Time dialog box will open. 

. Enter 0 for the FeedBack Mode (No Gain) and 
40.9 for the Relaxation Response Time. The 
scanrate will be automatically entered. 
Please Note: Normally the FeedBack Mode 
and Relaxation Response Time will be read 
in from your experimental data file. 

· Click OK. A new curve will be generated and plotted as a blue line (shown below as a 
wider line). This is the modified curve, for the passive mode, that removed the small 
amount of response-time broadening. The smaller peak of the repeated scan (using 
High-Gain FeedBack) is due to some non-reversibility of the sample. 
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Line Types for Fit Curves 

You may select a line type to plot your data or fit curves from the Plot Details dialog 
box. The Plot Details dialog box is available by double-clicking on the data plot, right-
clicking on the data plot and selecting Plot Details from the shortcut menu or selecting the 
desired data plot from the Data menu data list and selecting Format:Plot. 

The Line Group 

Select the desired line connection from the associated drop-down list. The line 
connection type affects interpolation results. The default line type for fit curves is 
Straight line. The most common methods of connecting the fit curve data points are 
straight, spline or B-spline: 

Straight: A straight line is displayed between data points. This type of line connection 
will not give a smooth representation of the fit curve if there are few data points. 

Spline: This option generates a cubic spline connection. To use the connection, the X 
values must be discrete and increasing. Since curvature information is held in memory, 
the spline resolution remains the same regardless of page magnification. The SplineStep 
variable in the ORIGIN.INI file controls the spline calculation increment. It is expressed 
in units of .1 point. This is usually the most satisfactory representation of the fit curve, 
but may exhibit an excursion from the actual fit curve if there is a sharp corner in the data. 
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Lesson 8: Other Useful Details 

B-Spline: The B-spline curve can be described by parametric equations. Unlike spline 
curves, which pass through the original data points, the B-spline curve winds around the 
original data points without passing through them. Thus this curve may not produce a 
satisfactory representation of the fit curve. For a complete discussion of the B-spline 
connection, see the Origin User's Manual. 

Inserting an Origin graph into Microsoft® Word 

There are two ways to include your Origin graph into Word (or other applications), you 
may import your graph into Word or you may share your graph with Word. When you 
import your graph, Word will display the graph as an object and it cannot be edited by 
Origin tools (although it may be resized or reposition in the Word document). When you 
share your graph, Word displays the graph as an object which can be edited by Origin, or 
linked to Origin and updated when the Origin graph changes. 
Please refer to the Origin manual for more information about Creating a Graphic 
Presentation. 

Importing your graph into Word 

• Create your graph in Origin and when you are satisfied with its appearance, select 
Edit:Copy page. 

• Open your Word document and click at the location where you want the graph to be 
located. 

• Select Edit:Paste Special. 

• Select Origin Graph Object from the As list box. 

• Select the Paste radio button. 

• Click OK. 

Linking your graph into Word 

• You must first create your graph in Origin and then save it as part of an Origin project 
(*.OPJ). 

• Open the saved Origin project (if it is not already opened) that includes the desired graph 
window. 

• Make the desired graph window active, select Edit:Copy Page. 

• Open your Word document and and click at the location where you want to insert the 
graph. 

• Select Edit:Paste Special. 
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DSC Data Analysis Tutorial Guide 

• Select Origin Graph Object from the As: list box 

• Select the Paste Link radio button. 

• Click OK. 

After your Origin graph is linked to Word you may return to the original Origin graph and 
make changes to the graph. These changes can be reflected in the Word document by: 

• Select Edit:Update Client from the Origin menu (to make immediate changes to the 
Word document graph). 

(Shortcut: You may quickly start Origin and load the linked graph by simply double-clicking 
on the graph while in Word. Origin will be started with the original document loaded, the 
changes can be made and by selecting Edit:Update Client, the changes will be transferred to 
the Word document.) 
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Appendix: Equations Used in Deconvolution 

Appendix: Equations Used to Deconvolute DSC Data 

I. Independent Transitions 

It will be assumed here that a protein (or other macromolecule) is composed of a number 
of structural domains A, B, C, ..., each of which is involved independently in a transition 
between the folded and unfolded forms (A = A', B = B', ...). Equilibrium constants will 
be expressed as fractions (KA = fA'/fA, KB = fB'/fB, ...) with the usual designation for the 
actual (i.e., calorimetric) molar enthalpy changes (ΔHA, ΔHB, ...). 
The total molar enthalpy of the system H will be 

H = H + f ΔH + f ΔH +. . . (1) N A ' B ' B 

The first term for the totally native form where all domains are in their folded state, HN, 
must be included since all ΔH values are measured relative to the folded form. The total 
molar heat capacity of the system Cp is the temperature derivative of the enthalpy in eq 1, 
so 

� δf A ' 

δT 
� � � 

' Δ Δ C C f C H + + +. . . (2) �
� 

= 

� � pN A pA A p 

where CpN is the molar heat capacity of the totally folded state, ΔCpA is the change in 
heat capacity for unfolding the A domain, and where the term in brackets will be repeated 
for each domain involved in unfolding. Remembering that fA = 1 - fA', then the 
fractional concentration of the primed species can be readily expressed in terms of the 
corresponding equilibrium constant 

f 
K A (3) 

A ' = 
1+ K A 

which can then be differentiated to give 

� � δf 
δT 

δ K ln K �
�
�

�

�
A ' � � �

�
�

A A (4) �
�

= 
2 δT (1 + K A ) � � 

The derivative on the right of eq 4 is known from elementary thermodynamics 

∗ δ ln K A ΔH �
�
�

� A 
2 

(5) = 
δT � RT 

* where ΔHA is the so-called van't Hoff heat change for the reaction which corresponds to 
the heat change for the cooperative unit which actually participates in the reaction. 
Substituting from eq's 3-5 into eq 2 then gives 
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� �



� 

+. . . (6) 
K ΔC K ΔH ∗ ΔH A pA A A A C = C + + pN 2 

RT 2 p (1 ) 1 + K + K A A 

Eq 6 is perfectly general at this point and can be applied to either two-state or non-two-
state transitions so long as all parameters are evaluated at the same temperature T. 

Model for Independent Two-State Transitions including ΔCp Effects. 
If we assume each transition is two-state, then all of the above van't Hoff ΔH* values 
become equal to the calorimetric ΔH values. If we further assume that CpN can be 
expressed as a linear function of temperature (CpN = B0 + B1 T), then eq 6 becomes 

� �




� 

+. . . (7) 
( ) K T ΔH T 2 K T ΔC ( ) ( ) A pA A A C p T ( ) = B 0 + B T + 1 + 

1 + K A T ( ) 
A T ( ( )) 2 

RT 2 1 + K 

where the temperature-dependent parameters Cp(T), KA(T), and ΔHA(T) have been 
indicated. We can express ΔHA(T) in terms of its temperature-independent value at the 
midpoint TmA and the heat capacity change for the transition ΔCpA, i.e., 

ΔH (T ) = ΔH + ΔC (T − T ) (8) A mA pA mA 

and then integrate eq 5 from TmA where KA(T) is unity to an unspecified temperature T 

ΔC 
K ( ) = exp A T 

�
�
� 

�
�
� 

(9) 
−ΔH � � � � T T pA mA 1 − − − mA − T T T ln �

�
�
�RT TmA RT T mA � � 

Now, eq 7 (using substitutions from eq's 8 and 9 for each transition A, B, ...) may be used 
to calculate the value of the system heat capacity Cp(T) at any temperature T once values 
of the temperature-independent fitting parameters B0, B1, TmA, ΔHmA, ΔCpA, TmB, 
ΔHmB, ΔCpB, ... are given. To begin curve-fitting with Origin, the operator indicates the 
number of transitions needed to fit the experimental DSC heat capacity curve, Cp(T)exp, 
and then initializes all of the Tm values so that Origin can provide guesses for each of the 
other fitting parameters. Knowing these, it then calculates Cp(T) from eq's 7-9 and 
compares these values with Cp(T)exp. Using Marquardt methods based on non-linear-
least-squares, the guesses for each parameter are then improved, the calculations carried 
out again, and this iterative process continued until there is no further improvement in the 
fit of the calculated Cp(T) to the experimental Cp(T)exp as indicated by a minimum value 
of chi2. 

Model for Independent Two-State Transitions excluding DCp Effects. 
When all heat capacity changes ΔCpA, ΔCpB, ... are assumed to be zero, certain 
simplifications can be made in eq's 7-9. Before curve-fitting begins, the operator 
subtracts a baseline from the data which effectively sets CpN equal to zero at all 

66 



       

 

               
               

            
              

  
 

      

 

       

 
 

                
                 

              
 

 
 

     
             

               
              

                   
              

          
      

 

      

                
                

     
 

      

 
                 

       

    

            
                 

              
    

 

    
   

    

 
  

 
 

 
 
 

   
    

     

  

 
  

 
 

 
 

Appendix: Equations Used in Deconvolution 

temperatures so that B0 and B1 are no longer used as fitting parameters. Incorporating 
this, setting all heat capacity changes to zero, and recognizing that all ΔHA(T) for each 
transition may be replaced by the temperature-independent heat ΔHmA (i.e., heat changes 
must be temperature-independent if there is no change in heat capacity), then eq's 7-9 
simplify to 

(T ) 2 K A (T )ΔH A T = +. . . (10) p 

A T RT 2 
C ( ) 2 (1 + K ( )) 

K ( ) = exp A T 
�
�
� 

−ΔH mA � − 1 �
�

T � 

TmA � 

�
�
� 

(11) 
RT 

where again the right-hand term in eq 10 must be repeated for each transition and where 
eq 11 must be evaluated for each transition. In this case the fitting parameters are TmA, 
ΔHmA, TmB, ΔHmB, ..., but otherwise the curve-fitting procedure is the same as described 
above. 

Model for Independent Non-two-state Transitions. 
Because of the extra fitting parameters required for the non-two-state vs two-state model, 
this model is only applied to transitions with no ΔCp. Before curve-fitting with this 
model, a progress baseline must be subtracted from the experimental data to remove the 
ΔC effects if they are present (this also sets CpN to zero at all temperatures). To treat p 
non-two-state transitions, the appropriate place to begin is eq 6 which still includes both 
calorimetric and van't Hoff heat changes. Indicating the temperature-dependent 
parameters, this can be rewritten as 

K T ΔH ∗ ΔH 
Cp T A ( ) mA mA (12) ( ) = 

2 
+ . . . 

1 + K A T RT 2 ( ( )) 
In this case, the equilibrium constants will be calculated as in eq 11 with the important 
exception that the van't Hoff heat, rather than the calorimetric, must be used since now the 
two will be different, i.e., 

K ( ) = exp A T 
�
�
� 

−ΔH ∗ 
mA 

RT 
�
�
�

1 − 
T � 

TmA � 

�
�
� 

(13) 

Eq's 12-13 are then used for curve-fitting in the usual way and the parameter set will be 
* ... TmA, ΔHmA, ΔHmA 

*,TmB, ΔHmB, ΔHmB 

II. Sequential Transitions 

Sequential transitions may occur in proteins (or other macromolecules) when the stability 
of each domain A, B, C, ... is dependent on whether other domains are folded or unfolded. 
The sequential model imposes a precise order in which domains must unfold for every 
molecule in solution, i.e., 
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DSC Data Analysis Tutorial Guide 

K K K K 1 2 3 4 

P P P P P = .... 0 = 1 = 2 = 3 = 4 
ΔH 1 ΔH 2 ΔH 3 ΔH 4 (14) 

where each step in the reaction scheme involves the unfolding of one of the domains in 
the appropriate sequence (i.e., step 1 is always the A domain, step 2 always the B domain, 
etc.). The total molar heat content of the system (relative to a value of zero being 
assigned to the P0 state) will be 

H = f 0 ⋅ 0 + f 1 ΔH 1 + f 2 (ΔH 1 + ΔH 2 ) + f 3 (ΔH 1 + ΔH 2 +ΔH 3 )+. . . (15) 

where the f's indicate the fractional concentration of each state and the ΔH's are the molar 
enthalpy changes for each step. Using the K values, all of the f values can be related to 
f0,, so that 

1 = f + f + f + f + ... 0 1 2 3 

1 = f (1 + K + K K + K K K + ...) 0 1 1 2 1 2 3 

K K K 1 1 1 2 f = ; f = ; f = ; . . . . . . (16) 0 1 2 Q Q Q 

where 

Q = 1 + K + K K + K K K +. . . . . . (17) 1 1 2 1 2 3 

Eq's 16 may be substituted into eq 15, which may then be differentiated with respect to 
temperature to obtain the system heat capacity. Since ΔH values are treated as 
temperature-independent in Origin's sequential model, most of the derivatives involve 
using the relation 

δ K K K . . . ( 1 2 ) �
�
� 

� ΔH 1 + ΔH + ΔH 3 + . . . � �
�
�

( K K K . . . ) 1 2 
3 2 (18) = 3 δT RT 2 � � 

The final expression for the heat capacity of the system then becomes 

2 ΔH 
T 

(ΔH 1 + ΔH 2 ) 2 � � 
T T K T . . . ( ( )( ) ) C p T ( ) = K 1 T ( ) T K ( )+ K ( )1 2 ( ) ( ) �

�
� 

1 . . . − Δ Δ Δ K H K H H + + + + 1 1 1 2 1 2 2 RT Q 2 RT Q � 

ΔH (ΔH + ΔH ) 1 1 2 K T + K T K T + 1 ( ) 1 ( ) 2 ( ) 
RT Q RT Q 

�
�
� 

� 
(19) . . . 

2 2 2 2 
� 

where the temperature-dependent quantities have been indicated in the usual way. The 
equilibrium constants can be evaluated in terms of the temperature-independent ΔH 
parameters from 

68 



       

 

  
	

  

 

  
	

     

 
               

           

       

          
       

 

        

 
              

                  
      

 

        

 
              

       
 

        

 
      

 

   

 

      

 
          

 

  

                
        

  
 

  
  

  

  
 

  
  

  

  
  

  

   
   

  
 

     
 

 

       

 

 

 

 
       

 
 
  

 
 

Appendix: Equations Used in Deconvolution 

�


� 

� 

� 

−ΔH � 1 1 1 − K ( ) = exp 1 T 
�
�
� R T Tm 1 

�


� 

� 

�
(20) 

−ΔH � 1 1 2 − T K ( ) = exp 
�
�
� 

2 R T Tm 2 

Using eq's 19-20 and fitting parameters K1, ΔH1, K2, ΔH2, ..., the fitting procedure is 
carried out as described above for the models involving independent transitions. 

III. Single Two-State Transition with Subunit Dissociation 

It sometimes happens with biological macromolecules having subunits that subunit 
dissociation occurs simultaneously with thermal unfolding, i.e., 

n [ A ] 
An = nA K = (21) [ An ] 

where n is the number of dissociable subunits and where the brackets signify molar 
concentrations of species. If f is the fraction of macromolecule in the A state and 1-f the 
fraction in the A state, then n 

[ An ] [ A ] 
1− f = f = (22) 

Ct nCt 

where Ct is the total bulk molar concentration (expressed as n-mer equivalents). The 
equilibrium constant, using eq's 21-22, then becomes 

f n 
n n −1 K = n C t (23) 

1 − f 

Using eq 23 and the expressions 

δ ln K T ( ) −ΔH A (T ) 
= 

1 R δ 
T 

Δ ( ) = ΔH (T − T ) (24) H T + ΔC mA pA mA 

and integrating from TmA (where f=0.5) to T then gives 

ΔC 
K T . ( ) = 0 5 n n n −1 n C −1 

t exp 
�
�
� 

−ΔH mA T ln 
T � �

�
� 

(25) 
� T � �pA 1 − − − mA − T T �
�

�
�RT TmA � RT TmA � 

Once K(T) is known then f(T) may be solved from eq 23 using numerical methods and 
the excess heat capacity calculated from the equation 
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� � 
� ΔH T 1 − f T ( ) ( ) 

C p ( ) = B + B T + f T ( )ΔC + (26) T 0 1 p 
A � 

RT 2 � n 
1 − n + 

� f T � ( ) � 

The above equations are general for any value of n so long as the bulk concentration Ct is 
expressed as n-mer equivalents. For systems which associate when unfolding occurs i.e., 

1 
A = A j (27) 

j 

the same equations are valid, providing the bulk concentration Ct is expressed as 
1 

monomer equivalents and that n in the above equations is equated to . 
j 

IV. Absolute Heat Capacity of Proteins 

The equation used to calculate Absolute Heat Capacity of Proteins is as follows: 

P W ΔC = g ρ( t ) V (1 + .00002 t ) [C ( t ) −ν (1 +αt ) C ( t )] p o o P P 

Where ΔΔΔΔCp (cal/deg) is the sample-buffer baseline minus the buffer-buffer baseline, go is 
the concentration of protein (gm/ml) in the solution, ρρρρ(t) is the relative density of water 
(stored in Origin as a polynomial in t), Vo is the nominal volume (ml) of the sample cell, t 
is the temperature in °C, CP

P (t) is the absolute heat capacity (cal/deg/gm) of the protein in 
solution, νννν is the partial specific volume of the protein (ml/gm), αααα is the coefficient of 
thermal expansion of the protein, and CW

P (t) is the unit-volume heat capacity of water 
(cal/deg/ml). CW

P (t) is calculated from literature data on the specific heat and density of 
water as a function of temperature, by fitting to a polynomial in temperature. The thermal 
coefficient of cubical expansion of tantalum is .00002. 

The above equation is solved for CP
P (t) from the experimental data file ΔΔΔΔCp, using the 

stored polynomial expressions for CW
P (t) and ρρρρ(t) as well as the operator-input parameters 

go, νννν, αααα, and Vo. 

This procedure assumes the relative density and the unit-volume heat capacity CW
P of the 

buffer solution can be replaced by the corresponding properties of pure water. This 
should be a very good approximation at electrolyte concentrations commonly used in 
buffer solutions, but would be less accurate at very high electrolyte concentrations (>1M) 
or in the presence of high concentrations of organic additives. Also, the value obtained 
for CP

P depends strongly on the partial specific volume of protein, so it is desirable to 
have an experimental value of νννν for the protein in question at a single temperature, at the 
least. The coefficient of thermal expansion is typically small (~ 10-3 - 10-4) and exerts 
only a small effect on the CP

P value over a moderate temperature range. 
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Index 

A 
Absolute heat capacity 

equations, 70 
fitting example, 54–57 

Active data set, 11 

B 
Baseline, 15–16, 37–44 

adjust linear segments, 39–40 
adjust the default baseline, 43 
baseline menu commands, 38 
baseline session, 38–42 
change line connect type, 43–44 
cubic connect baseline, 41–42 
default name, 44 
linear connect baseline, 41 
move baseline by cursor, 42 
progress baseline, 40–41 
restoring, 20–21 
select baseline type, 40 
step baseline, 42 
subtract from DSC data, 44 
viewing worksheet data for, 44 

C 
Calibration, 21–22 
Chi-Sqr button, 19 
Chi-Sqr minimization, 59 
Curve fitting, 17–21 

choosing a model, 46 
fitting iterations, 50 
fitting models described, 17, 45–46 
fitting session, 18–20 
formatting parameters text, 21 
Line types, 62–63 
to dissociation w/dCp, 51–53 
to the 2-state model, 18–20 
to the 2-state w/dCp model, 20–21 

D 
Data files 

automatic scan rate normalization, 8 
keeping time data, 8 
offsetting data, 8 
opening, 9–11 

Data Selector tool, 23–27 
hiding data markers, 33 
setting integration range, 29–31 

Data set 
change line connect type, 43–44 
create baseline for, 15–16 
create new data set, 34 

deleting selected segment, 25 
fitting a curve to, 17–21 
importing, 6 
integrating, 29–35 
normalizing, 13–15 
opening worksheet for, 12–13, 44 
plotting, 34–35 
selecting a plot segment, 24–25 
set as active, 11 
subtracting reference, 11–12 

Deconvolution. see Curve fitting 
Dissociation w/dCp, 51–53 

E 
EndInteg macro, 31 

F 
Fitting. see Curve fitting 
Fitting parameters 

defined, 45–46 
for four models, 17 

Fitting Session, 18–20 

H 
H parameter (heat change), 45–46 
Hv parameter (van't Hoff heat change), 45–46 

I 
Import Multiple ASCII dialog box, 9–10 
Importing data, 6 
Installing Origin, 3–4 
Integration, 29–35 

copy integration area data, 34 
displaying integration results, 32 
EndInteg macro, 31 
formatting integration results, 32–33 
integrating selected range, 31 
integration results, 29, 31 
plot integration area data, 34–35 
setting integration range, 29–31 

Isothermal scan, 6 

L 
LabTalk script language, 34 
Layer Control dialog box, 34–35 
Line Types for fit curves, 62–63 

M 
Math dialog box, 21 
Menu levels, 4–5 
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N 
Normalizing data, 13–15 

O 
Offsetting multiple DSC files, 8 
Opening and Analyzing Previous Versions of Origin 

(*.ORG) Documents, 6 
Opening DSC data files, 9–10 
Opening Worksheet window, 12–13 

P 
Page Preview mode, 33 
Page View mode, 5, 21, 33 
Plot window 

maximizing, 38 
Print View mode, 5, 21 

R 
Reference data 

subtracting from sample data, 11–12 
Registering Origin, 4 
Response Time, 59–62 

FeedBack Modes, 60 
relaxation time constant, 60 

Response time button, 60 

S 
Scan rate normalization, 8 

and instrument calibration, 22 
Screen View mode, 33 
Scripting, 34 
Set Default Directory, 10 
Starting Origin, 7 
Subtracting reference data, 11–12 
System Requirements, 3 

T 
Text formatting, 21, 32–33 
Tolerance, 50 

V 
View mode 

and screen refresh rates, 5 
available types, 5 

View Mode, 33 

W 
Window View mode, 5 
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